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Introduction

The strength reduction method in combination with finite element analysis is a tool to find
the factor of safety (FOS) in geomechanics, particularly for the stability of slopes and
embankments. In the strength reduction method, the characteristic material properties are
gradually reduced until failure occurs. Although the factor of safety has different
definitions in other context, in the context of geotechnical problems it is defined with

respect to the strength parameters of the soil, as discussed in Ref. 1.

The strength reduction method is applicable to linear failure criteria, like the Mohr—
Coulomb criterion. When the Mohr—Coulomb criterion is used with the strength
reduction method, the cohesion, the angle of internal friction, and the dilatation angle are
simultaneously reduced until mechanical equilibrium is lost. Decreasing the material
parameters results in reduction of the shear strength of the soil, which eventually becomes
unstable. This phenomena produces a collapse of the slope for a certain combination of
loads, material parameters, and boundary conditions. The ratio between the initial
cohesion and the cohesion at failure gives the factor of safety (FOS). More details of the
method are given in Ref. 1 and Ref. 2.

The geometry, boundary conditions, loading conditions, and material parameters in this
example are the same as discussed in Ref. 1. Quartic order shape functions are used to
match the discretization used in Ref. 1.

Model Definition

Figure 1 shows the cross section of the soil embankment. The lengths L} and L, are 85 m,
and 20 m, respectively, and the heights of the embankment H; and H, are 20 m and 10 m,
respectively. The slope angle o varies from 15° to 45°.

Figure 1: Dimensions of the slope.
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The material properties for both associative and nonassociative plasticity are summarized
in Table 1, and taken from Ref. 1

TABLE |I: MATERIAL PROPERTIES.

PROPERTY MATERIAL SET | MATERIAL SET 2
E 20 MPa 20 MPa

v 03 03

c 20 kPa 20 kPa

0 25° 25°

T} 0° 25°

p 1940 kg/m® 1940 kg/m®

A plane strain approximation is used to model the soil embankment in 2D. The effects of
gravity are also included. The material properties for the Mohr-Coulomb model are
parameterized with respect to a factor of safety parameter, FOS. A parametric study
increases the FOS parameter, thereby reducing the strength of the soil with every
parameter step. The actual factor of safety is the value of the FOS parameter at which the

model no longer converges, which is an indication of the collapse of the slope.

The Mohr-Coulomb yield function F and plastic potential € are

F = m@+¥11—0cos<b (1)
Q = mq@+§%211—0cosT (2)

where I is the first stress invariant and /5 is the second deviatoric stress invariant. The
parameterized cohesion C, parameterized angle of internal friction @, and parameterized

dilatation angle @ are given as

C = FLOS’CD = atan(%},‘{‘ = atan(%,a—cr;ég) 3)

where c is the cohesion, ¢ is the angle of internal friction, and y is the dilatation angle.

Note that ¢, ¢, and y are initial, unreduced material parameters. For the associative flow
rule, ¢ = y.

For the nonassociative flow rule, y is kept constant as long as it is smaller than @, see Ref. 2
for details. However, in this example, y is zero when using the nonassociative flow rule,
so no special treatment is needed, and Equation 3 is applicable to the associative as well as
the nonassociative flow rule.
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For the nonassociative flow rule, the strength reduction method might trigger numerical
instabilities, which in turn can result in a nonunique failure surface and FOS. To avoid
potential instabilities and convergence issues, the Davis procedure B approach, as
suggested in Ref. 1 and Ref. 2, is used. For this approach, the associative flow rule is
applied with reduced values of the cohesion and the angle of internal friction to capture
the effects of the nonassociative flow rule. The reduced cohesion ¢' and the reduced angle

of internal friction ¢' are given by
¢' = Be, ¢ = atan(ftand) (4)

where the reduction factor B is

cos  atan($222)} cos atan(422Y))

) FOS FOS
1- sin(atan(%)) sin(atan (tFa_(I;EED

Hence, Equation 3 is rewritten in terms of the reduced cohesion ¢' and the reduced angle
of internal friction ¢' for the associative and nonassociative flow rules, as the reduction

factor B is unity for the associative flow rule.

Results and Discussion

The factor of safety (FOS) for different slope angles is shown in Figure 2. The FOS
decreases as the slope angle increases, which is expected. The FOS for the same slope
inclination with the nonassociative flow rule (material set 1) is always smaller than for the
associative flow rule (material set 2), but the influence of the nonassociative flow rule is
marginal for the chosen material parameters. The results presented in Figure 2 are in good

agreement with the results presented in Figure 4 of Ref. 1.
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Figure 2: Factor of safety versus slope angle.

The equivalent plastic strain for different slope angles just before collapse is shown in
Figure 3 and Figure 4 for the two material sets. The localization of plastic strains in the
figures give an indication of the failure surface for different slope angles. It is evident that

for lower slope angles, multiple failure surfaces develop in the embankment.

A 3D visualization of the displacement for a slope angle equal to 45° is shown in Figure 5
and Figure 6 for both material sets. The results qualitatively are in good agreement with

the results presented in Figure 2 of Ref. 1. The figures also clearly show how the parts of
the embankment outside the slip surface starts sliding once the material becomes unstable.
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Figure 3: Equivalent plastic strain just before collapse for material set 1.
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Figure 4: Equivalent plastic strain just before collapse for material set 2.
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Material Parameter Set 1, alpha=45 FOS(40)=1.39 Surface: Displacement magnitude (m)
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Figure 5: Displacement magnitude of the soil embankment just before slope collapse for
material set 1.

Material Parameter Set 2, alpha=45 FOS(48)=1.47 Surface: Displacement magnitude (m)
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Figure 6: Displacement magnitude of the soil embankment just before slope collapse for
material set 2.
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Notes About the COMSOL Implementation

A Mesh Control Domain is added to the Geometry node, where a denser mesh is prescribed
in the region where soil slippage is expected. The mesh control domain is removed from
the geometry sequence once the mesh is generated, so this virtual domain is not visible in
the physics selections.

Two stationary study steps are added. The first study step computes the in-situ stresses due
to gravity. The Mohr-Coulomb criterion is added to the second study study to compute
the elastoplastic failure due to the combined effect of gravity and the reduction in strength,
where the initial stresses generated in the first step are incorporated in the analysis with the
help of an Initial Stress and Strain node.

Two outer parametric sweeps are added to change the slope angle and the set of material
parameters.

Because the model stores a NaN solution corresponding to the nonconverged values of the
FOS, the generation of default plots can be problematic, as default plots are set to portrait
the last parameter value. Also, finding the last converged FOS parameter value manually
for each value of the slope angle and material parameter set can be cumbersome. To avoid
these issues, use a model method to generate a 1D plot for the factor of safety versus slope
angle for each material parameter set. The model method also generates a von Mises stress
plot, a 3D displacement plot, as well as plastic strain plots for each slope angle for the two
material sets.

The model method is written assuming that a certain dataset tag is available and that the
intended plots, functions, and datasets are not already created. Although fail-safe usage
conditions and error messages are added, the model method could fail if the default
material, geometry, study, or result parameters or nodes change. The model method then

has to be modified according to the current model setup.
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Application Library path: Geomechanics_Module/Verification_Examples/
strength_reduction_method

Modeling Instructions

From the File menu, choose New.

NEW
In the New window, click Model Wizard.

MODEL WIZARD

2
3
4
5
6

In the Model Wizard window, click Q 2D.

In the Select Physics tree, select Structural Mechanics>Solid Mechanics (solid).
Right-click and choose Add Physics.

Click @ Study.

In the Select Study tree, select General Studies>Stationary.

Click [~/ Done.

Parameters for the model geometry, material and solver are available in the appended text
files.

GLOBAL DEFINITIONS

Geometry and Solver Parameters

1
2

In the Model Builder window, under Global Definitions click Parameters 1.

In the Settings window for Parameters, type Geometry and Solver Parameters in the
Label text field.

Locate the Parameters section. Click Load from File.

Browse to the model’s Application Libraries folder and double-click the file
strength_reduction_method_parameters.txt.

Material Parameters

1
2

In the Home toolbar, click Pi Parameters and choose Add>Parameters.

In the Settings window for Parameters, type Material Parameters in the Label text
field.
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3 Locate the Parameters section. Click

Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file

strength_reduction_method_material_parametersi.txt

5 In the Home toolbar, click Pj

Parameter Case.

6 In the Settings window for Case, type Material Parameter Set 1 in the Label text

field.

7 In the Home toolbar, click Pj

Parameter Case.

8 In the Settings window for Case, type Material Parameter Set 2 in the Label text

field.

9 Locate the Parameters section. Click

Load from File.

10 Browse to the model’s Application Libraries folder and double-click the file

strength_reduction_method_material_parameters2.txt

DEFINITIONS

Define the parameterized cohesion and angle of internal friction for Mohr-Coulomb

criterion.

Variables |

I In the Model Builder window, expand the Component | (compl)>Definitions node.

2 Right-click Definitions and choose Variables.

3 In the Settings window for Variables, locate the Variables section.

4 In the table, enter the following settings:

Name Expression Unit Description
beta_f cos(atan(tan(phi)/F0S))* Reduction
cos(atan(tan(psi)/F0S))/(1- factor
sin(atan(tan(phi)/F0S))*
sin(atan(tan(psi)/F0S)))
cr beta_f*c Pa Reduced
cohesion
phi_r atan(beta_f*tan(phi)) rad Reduced
friction angle
c_p c_r/FOS Pa Parameterized
cohesion
phi p atan(tan(phi_r)/FOS) rad Parameterized

friction angle

10 | STRENGTH REDUCTION METHOD FOR SLOPE STABILITY



GEOMETRY |

Polygon | (poll)
I In the Geometry toolbar, click /1 Polygon.

In the Settings window for Polygon, locate the Coordinates section.

From the Data source list, choose Vectors.

In the y text field, type 0, 0, H1+H2,H1+H2,H1,H1.

2
3
4 In the x text field, type 0, L1,L1,L2+H2/tan(alpha),L2,0.
5
6 Click ™ Build Selected.

Polygon 2 (pol2)
In the Geometry toolbar, click /1 Polygon.

Split the geometry with a polygon to add a Mesh Control Domain.

I In the Settings window for Polygon, locate the Object Type section.

2 From the Type list, choose Open curve.

3 Locate the Coordinates scction. From the Data source list, choose Vectors.
4

In the x text field, type 0.8*L2,0.8*L2,1.3*L2+H2/tan (alpha),1.3*L2+H2/
tan(alpha).

5 In the y text field, type H1,H1/2,H1/2,H1+H2.

6 Click ®] Build Selected.

Mesh Control Domains | (mcdl)

I In the Geometry toolbar, click 5= Virtual Operations and choose Mesh Control Domains.
2 On the object fin, select Domain 2 only.

3 In the Settings window for Mesh Control Domains, click [ Build Selected.

Change the discretization to Quartic Lagrange.

SOLID MECHANICS (SOLID)

I In the Model Builder window, under Component | (compl) click Solid Mechanics (solid).
2 In the Settings window for Solid Mechanics, click to expand the Discretization section.
3 From the Displacement field list, choose Quartic Lagrange.

Linear Elastic Material |

In the Model Builder window, under Component | (comp1)>Solid Mechanics (solid) click

Linear Elastic Material |I.
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Soil Plasticity |
I In the Physics toolbar, click '_:ﬂ' Attributes and choose Soil Plasticity.

2 In the Settings window for Seil Plasticity, locate the Soil Plasticity section.
3 From the Yield criterion list, choose Mohr-Coulomb.
4 From the Plastic potential list, choose Associated.

Linear Elastic Material |

In the Model Builder window, click Linear Elastic Material I.
Initial Stress and Strain |
I In the Physics toolbar, click '_:ﬂ' Attributes and choose Initial Stress and Strain.

Add two study steps in order to account for the in situ stresses due to gravity. Add the
in situ stresses computed in the first study step as initial stresses for the second study

step. You can access these stresses using the withsol operator as follows:

2 In the Settings window for Initial Stress and Strain, locate the Initial Stress and Strain
section.

3 In the Sy table, enter the following settings:

withsol('sol2', withsol('sol2', withsol('sol2',
solid.sx) solid.sxy) solid.sxz)
withsol(’sol2’,solid.sxy) withsol('sol2', withsol('sol2',
solid.sy) solid.syz)
withsol(’sol2’,solid.sxz) withsol(’sol2’,solid.syz) withsol('sol2',
solid.sz)
Gravity |

I In the Physics toolbar, click @ Domains and choose Gravity.

2 In the Settings window for Gravity, locate the Domain Selection section.

3 From the Selection list, choose All domains.

Roller |

I In the Physics toolbar, click & Boundaries and choose Roller.

2 Select Boundaries 1 and 6 only.

Fixed Constraint |

I In the Physics toolbar, click & Boundaries and choose Fixed Constraint.

2 Select Boundary 2 only.
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MATERIALS

Soil Material
I In the Model Builder window, under Component | (compl) right-click Materials and

choose Blank Material.
2 In the Settings window for Material, type Soil Material in the Label text field.

3 Locate the Material Contents section. In the table, enter the following settings:

Property Variable Value Unit Property
group
Young’s E E_soil Pa Young’s
modulus modulus and
Poisson’s
ratio
Poisson’s nu nu_soil | Young’s
ratio modulus and
Poisson’s
ratio
Density rho rho_soil kg/m? Basic
Cohesion cohesion c_p Pa Mohr-
Coulomb
Angle of internalphi phi_p rad Mohr-
internal Coulomb
friction
MESH 1

Free Triangular |

In the Mesh toolbar, click r__ Free Triangular.

Size

Use an extremely fine mesh in the mesh control domain.

I In the Model Builder window, click Size.

2 In the Settings window for Size, locate the Element Size section.

3 From the Predefined list, choose Finer.

Size |

I In the Model Builder window, right-click Free Triangular 1 and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.
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3 From the Geometric entity level list, choose Domain.

4 Select Domain 2 only.

5 Locate the Element Size section. From the Predefined list, choose Extremely fine.

6 In the Model Builder window, right-click Mesh | and choose Build All.

The material strengths are parameterized with the help of the FOS parameter. Add an
auxiliary sweep for FOS in the second study step. For certain values of FOS the solution

will not converge and the default plots, which are set to the last FOS value, will give an

error. Disable the default plots for this study in order to avoid the error message.

Add two Parametric Sweep nodes to change the slope angle and material parameters.

STUDY |
I In the Model Builder window, click Study 1.

2 In the Settings window for Study, locate the Study Settings section.

3 Clear the Generate default plots check box.

Step |: Stationary

I In the Model Builder window, under Study | click Step I: Stationary.

2 In the Settings window for Stationary, locate the Physics and Variables Selection section.
3 Sclect the Modify model configuration for study step check box.

4 In the tree, select Component I (Comp1)>Solid Mechanics (Solid)>
Linear Elastic Material 1>Soil Plasticity | and Component | (Compl)>
Solid Mechanics (Solid)>Linear Elastic Material 1>Initial Stress and Strain I.

5 Right-click and choose Disable.
Stationary 2
I In the Study toolbar, click E Study Steps and choosc Stationary>Stationary.

2 In the Settings window for Stationary, click to expand the Values of Dependent Variables

section.

3 Find the Initial values of variables solved for subsection. From the Settings list, choose

User controlled.
4 From the Method list, choose Solution.
5 From the Study list, choose Study I, Stationary.
6 Click to expand the Study Extensions section. Select the Auxiliary sweep check box.
7 Click + Add.
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8 In the table, enter the following settings:

Parameter name Parameter value list Parameter unit

FOS (Factor of safety) range(stepi,steps,stepf)

Parametric Sweep
I In the Study toolbar, click

% Parametric Sweep.
2 In the Settings window for Parametric Sweep, locate the Study Settings section.
3 Click + Add.

4 In the table, enter the following settings:

Parameter name Parameter value list Parameter unit
alpha (Slope angle) range(stepi_a,steps_a, deg
stepf_a)

Parametric Sweep 2
I In the Study toolbar, click

% Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.
3 From the Sweep type list, choose Parameter switch.

4 Click + Add.

5 In the table, enter the following settings:

Switch Cases Case numbers

Material Parameters All range(l,1,2)

Solution | (soll)
I In the Study toolbar, click M= Show Default Solver.

2 In the Model Builder window, expand the Selution I (soll) node.

3 In the Model Builder window, expand the Study 1>Solver Configurations>
Solution | (soll)>Stationary Solver 2 node, then click Parametric 1.

In the Settings window for Parametric, locate the General section.

From the On error list, choose Store empty solution.

Click to expand the Continuation section. Select the Tuning of step size check box.
In the Initial step size text field, type steps/10.

In the Minimum step size text field, type steps/10.

NV 0 N o0 1 A

In the Maximum step size text field, type steps.
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10 From the Predictor list, choose Constant.
Use a double dogleg solver in order to improve the convergence.

Il In the Model Builder window, under Study 1>Solver Configurations>Solution | (soll)>
Stationary Solver 2 click Fully Coupled 1.

12 In the Settings window for Fully Coupled, click to expand the Method and Termination
section.
13 From the Nonlinear method list, choose Double dogleg.

14 In the Study toolbar, click = Compute.

Create model methods to generate the required plots. Note that the method editor is only
available in the Windows® version of the COMSOL Desktop.

ROOT

I From the File menu, choose Preferences.

2 In the Preferences dialog box, click OK.

APPLICATION BUILDER
In the Home toolbar, click A Application Builder.

METHODS

plotUtil
I In the Home toolbar, click ““ More Libraries and choose Utility Class.

2 Right-click utill and choose Rename.

3 In the Rename Utility Class dialog box, type plotUtil in the New name text field.
4 Click OK.

5 Right-click plotUtil and choose Edit.

6

Copy the following code into the plotUtil window:

//This utility creates requested plots

/ /Method to create plot group
public static ResultFeature createPlot(String dset, String plottype, String tag,
String label, String title, String view, boolean showlegends,boolean plotArray,
double[][] index, int k) {
int lastloopn = (int) Math.round(model.param().evaluate("nstep_a")-1);
ResultFeature plot = model.result().create(tag, plottype);
model.result(tag).label(label+Integer.toString(k+1));
with(model.result(tag));
set("data", dset);
try {
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setIndex("looplevel", k+1, 2);

setIndex("looplevel", index[k][lastloopn], 0);

}

catch (Exception e) {

error("The required looplevel is not available in the dataset, check the model
or model method.");

}
if (!title.equals("default")) {
set("titletype", "manual");
set("title", title);
set("paramindicator", "");
}
if (!showlegends)
set("showlegends", false);
if (!view.equals("default"))
set("view", view);
if (plotArray) {
set("plotarrayenable", true);
set("arrayshape", "square");
}
set("edges", false);
endwith();
return plot;

}

//Method to create surface plot

public static ResultFeature createSubPlot(ResultFeature pg, String dset, String
plottype, String tag, String expr, boolean isPlasticityPlot, boolean
isStressPlot, double[][] index, int k, int i) {

ResultFeature pgsub = pg.create(tag, plottype);

with(pgsub);

set("expr", expr)

if (isPlasticityPlot)

set("colortable", "AuroraAustralisDark");

if (!dset.endsWith("fromParent")) {

set("data", dset);

try {

setIndex("looplevel", k+1, 2);

setIndex("looplevel", i+1, 1);

setIndex("looplevel", index[k][i], 0);

}

catch (Exception e) {

error("The required looplevel is not available in the dataset, check the model
or model method.");

}

endwith();
return pgsub;
}

NEW METHOD
I In the Application Builder window, right-click Methods and choose New Method.

2 In the New Method dialog box, type generatePlots in the Name text field.
3 Click OK.
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generatePlots
I In the Application Builder window, under Methods click generatePlots.

2 Copy the following code into the generatePlots window:

String dset = "dset3"; //Required parametric dataset tag

if (!contains(model.result().dataset().tags(), dset)) //Throw an exception if
accessing dataset fails

error("The solution with the required dataset tag is not available, check the
model or model method.");

int nstep = (int) Math.round(model.param().evaluate("nstep"));

int nstepa = (int) Math.round(model.param().evaluate("nstep_a"));
int nmat = (int) Math.round(model.param().evaluate("nmat"));

int stepsa = (int) Math.round(model.param().evaluate("steps_a")*180/
model.param().evaluate("pi"));

double[][] FOS = new double[nmat][nstepa];

double[][] alpha = new double[nmat][nstepa];

double[][] index = new double[nmat][nstepa];

boolean isEvaluationGrpExists =
contains(model.result().evaluationGroup().tags(), "egl1");
boolean isExtrusionDsetExists = contains(model.result().dataset().tags(),
"extr1");
boolean isViewExists = contains(model.view().tags(), "view3");
boolean isInterpolationFunExists = false;
boolean isNodeGrpExists = false;
boolean isPlotGrpExists = false;
for (int k = 0; k < nmat; k++) {
String int1 = "int"+Integer.toString(k+1);
if (contains(model.func().tags(), int1)) {
isInterpolationFunExists = true;
break;
}
}
for (int k = 0; k < nmat; k++) {
String grp = "grp"+Integer.toString(k+1);
if (contains(model.nodeGroup().tags(), grp)) {
isNodeGrpExists = true;
break;
}
}

for (int k = 0; k < 3*nmat+1; k++) {

String pg = "pg"+Integer.toString(k+1);

if (contains(model.result().tags(), pg)) {
isPlotGrpExists = true;

break;

}
}
if ((isEvaluationGrpExists || isExtrusionDsetExists || isInterpolationFunExists
|| isPlotGrpExists || isNodeGrpExists || isViewExists)) {

/** Opens a confirm dialog to check whether the user would like to
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* delete the existing model nodes and regenerate again.*/

String answer = confirm("Certain nodes already exist, do you want to delete
them and regenerate again?", "Delete and regenerate", "Yes", "No");

if (answer.equals("Yes")) {

if (isEvaluationGrpExists)
model.result().evaluationGroup().remove("egl");

if (isExtrusionDsetExists)
model.result().dataset().remove("extri");

if (isInterpolationFunExists) {

for (int k = 0; k < nmat; k++) {

String int1 = "int"+Integer.toString(k+1);

if (contains(model.func().tags(), int1)) {
model.func().remove(int1);

}

}

}

if (isPlotGrpExists) {

for (int k = 0; k < 3*nmat+1; k++) {

String pg = "pg"+Integer.toString(k+1);

if (contains(model.result().tags(), pg)) {
model.result().remove(pg);

}

}

}

if (isNodeGrpExists) {

for (int k = 0; k < nmat; k++) {

String grp = "grp"+Integer.toString(k+1);

if (contains(model.nodeGroup().tags(), grp)) {
model.nodeGroup().remove(grp);

}

}

}

if (isViewExists)

model.view().remove("view3");

}

else {

if (isEvaluationGrpExists)

error("The evaluation group already exists, check the model or model method");
if (isExtrusionDsetExists)

error("The extrusion dataset already exists, check the model or model method.");
if (isInterpolationFunExists)

error("The interpolation function already exists, check the model or model
method.");

if (isPlotGrpExists)

error("The plot already exists, check the model or model method.");
if (isNodeGrpExists)

error("The node group already exists, check the model or model method.");
if (isViewExists)

error("The view already exists, check the model or model method.");
}

}

model.result().evaluationGroup().create("eg1", "EvaluationGroup");
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with(model.result().evaluationGroup("egl1"));
set("data", dset);

setIndex("looplevelinput", "manual", 2);
setIndex("looplevelinput", "manual", 1);
setIndex("looplevelinput", "manual", 0);
set("includeparameters", false);

endwith();

model.result().evaluationGroup("egl1").create("pevi", "EvalPoint");

model.result().evaluationGroup("eg1").feature("pevi").selection().set(2);
with(model.result().evaluationGroup("eg1").feature("pevi"));
setIndex("expr", "alpha", 0);
setIndex("unit", "deg", 0);
setIndex("expr", "FOS", 1);
setIndex("unit", 1, 1);
setIndex("expr", "u", 2);
endwith();

for (int k = 0; k < nmat; k++) {
String int1 = "int"+Integer.toString(k+1);
model.func().create(int1, "Interpolation");

model.func(int1).label("FOS_MatSet"+Integer.toString(k+1));
for (int j = 0; j < nstepa; j++) {

for (int 1 = 0; i < nstep; i++) {
with(model.result().evaluationGroup("eg1"));
setIndex("looplevel", new int[]{k+1}, 2);
setIndex("looplevel"”, new int[]{j+1}, 1);
setIndex("looplevel", new int[]{i+1}, 0);
model.result().evaluationGroup("eg1").run();

double[][] FOS1 = model.result().evaluationGroup("eg1").getReal();
double u = FOS1[0][2];

if (Double.isNaN(u))

break;

FOS[k][j] = FOS1[0]1[1];
alpha[k][j] = FOS1[0][0];
index[K][j] = i+1;
endwith();

}

model.func(int1).setIndex("table", FOS[KI[jl, i, 1);
model.func(int1).setIndex("table", alpha[k][jl, j, 0);

}

model.func(int1).set("argunit", "deg");
model.func(int1).set("fununit", "1");
if (k ==0) {

model.func(int1).createPlot("pgl");
model.result("pg1").label("Factor of Safety vs. Slope Angle");
model.result("pg1").set("titletype", "label");
model.result("pgl1").set("xlabelactive", true);
model.result("pg1").set("xlabel", "alpha (deg)");
model.result("pgl1").set("ylabelactive", true);
model.result("pg1").set("ylabel", "FOS (1)");
model.result("pgl1").feature("plot1").set("legend", true);
model.result("pg1").feature("plot1").set("legendmethod", "manual");
(

).
).
).
).
).
).
).
model.result("pgl1").feature("plot1").setIndex("legends", "Material Set "+
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Integer.toString(k+1), 0);

}

else {

String plot1 = "plot"+toString(k);

String plot2 = "plot"+toString(k+1);

String dataset = model.result("pgl1").getString("data");
model.result().dataset(dataset).set("function", "all");
model.result("pgl1").feature().duplicate(plot2, plotl);
model.result("pgl1").feature(plot2).set("expr", "int"+Integer.toString(k+1)+
"(t[1/m][deg]l)");

model.result("pgl1").feature(plot2).setIndex("legends", "Material Set "+
Integer.toString(k+1), 0);

}

}

model.result().evaluationGroup().remove("eg1");
model.result("pgl").run();

//Create an extrusion dataset for 3D plots
model.result().dataset().create("extr1", "Extrude2D");
with(model.result().dataset("extri1"));

set("data", dset);

set("zvar", "Z");
set("zmax", "L1+L2");
endwith();

//Create a camera view

model.view().create("view3", 3);

model.view("view3").camera().set("position", new int[]{-164, 120, 740});
model.view("view3").camera().set("up", new String[]{"0.02", "0.97", "-0.14"});
model.view("view3").camera().set("target", new int[]{42, 14, 52});
model.view("view3").camera().setIndex("viewoffset", -0.1, 0);
model.view("view3").camera().set("viewoffset", new double[]{-0.1, -0.016});
model.view("view3").camera().set("zoomanglefull", 13);
model.view("view3").set("locked", true);

for (int k = 0; k < nmat; k++) {
int n = 3*k+2;
String pg2 = "pg"+toString(n);
String pg3 = "pg"+toString(n+1);
String pg4 = "pg"+toString(n+2);

//von Mises Stress Plot
ResultFeature pgs = plotUtil.createPlot(dset, "PlotGroup2D", pg2, "von Mises

Stress ", "default", "default", true, index, k);

plotUtil.createSubPlot(pgs, "fromParent", "Surface", "surfi", "solid.mises",
false, true,false, index, k, 0);

pgs.run();

//Equivalent Plastic Strain Plot
ResultFeature pge = plotUtil.createPlot(dset, "PlotGroup2D", pg3, "Equivalent

Plastic Strain ", "Equivalent plastic strain (1)", "default", true, true, index,
k) ;

ResultFeature tlan = pge.create("tlani", "TableAnnotation");
tlan.set("source", "localtable");
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tlan.set("latexmarkup", true);
tlan.set("showpoint", false);
double jj = 0.0;

for (int 1 = 0; i < nstepa; i++) {
int D = 15+i*stepsa;

double aposX = 25;

double aposY = (int) jj*55;

if (i%2 == 1) { //0dd index

aposX = 125;

}

string lable = "\[[I][ot \\;=\\;"+D+"*\\circ\\]";
String surf = "surf"+toString(i+1);

ResultFeature pges = plotUtil.createSubPlot(pge, dset, "Surface", surf,
"solid.epe", true, false, index, k, i);

if (i > 0) {

String surfprev = "surf"+Integer.toString(i);
pges.set("inheritplot", surfprev);

}

tlan.setIndex("localtablematrix", aposX, i, 0);
tlan.setIndex("localtablematrix", aposY, i, 1);
tlan.setIndex("localtablematrix", lable, i, 2);

ij += 0.5;
}
pge.run();

//3D Displacement Plot

ResultFeature pgd = plotUtil.createPlot("extr1", "PlotGroup3D", pg4,
"Displacement ", "default", "view3", true,false, index, k);
plotUtil.createSubPlot(pgd, "fromParent", "Surface", "surfi", "solid.disp",
false, false, index, k, 0);

pgd.run();

//Node group

String grp = "grp"+Integer.toString(k+1);

model.nodeGroup().create(grp, "Results");

model.nodeGroup(grp).set("type", "plotgroup");
model.nodeGroup(grp).add("plotgroup", pg2);
model.nodeGroup(grp).add("plotgroup", pg3);
model.nodeGroup(grp).add("plotgroup", pg4);
model.nodeGroup(grp).label("Results: Material Set "+Integer.toString(k+1));
model.nodeGroup(grp) .placeAfter("plotgroup", "pgl1");

//Rearrange the groups

if (k == nmat-1) {

if (contains(model.nodeGroup().tags(), "grp2"))
model.nodeGroup().move("grp2", 3);

}

METHODS
In the Home toolbar, click (‘ Model Builder to switch to the main desktop.

22 | STRENGTH REDUCTION METHOD FOR SLOPE STABILITY



Generate plots using the model methods.

MODEL BUILDER
I In the Home toolbar, click <@ Model Builder.

2 Click L' Method Call and choose generatePlots.

GLOBAL DEFINITIONS

Generate Plots
I In the Model Builder window, under Global Definitions click GeneratePlots 1.

2 In the Settings window for Method Call, type Generate Plots in the Label text field.
3 In the Tag text field, type GeneratePlots.
4 Click ﬁ Run.

RESULTS
Go to the generated plots in order to visualize the failure in the embankment with the two

different material parameter sets.

Factor of Safety vs. Slope Angle
I In the Model Builder window, expand the Results node, then click
Factor of Safety vs. Slope Angle.

2 In the Factor of Safety vs. Slope Angle toolbar, click Plot.

Results: Material Set |

In the Model Builder window, expand the Results>Results: Material Set | node.

Surface |
I In the Model Builder window, expand the Results>Results: Material Set 1>

Equivalent Plastic Strain | node, then click Surface I.
2 In the Settings window for Surface, click to expand the Range section.
3 Seclect the Manual color range check box.
4 In the Maximum text field, type 0.15.
5 In the Equivalent Plastic Strain | toolbar, click Plot.

Results: Material Set 2

In the Model Builder window, expand the Results>Results: Material Set 2 node.
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Surface |
I In the Model Builder window, expand the Results>Results: Material Set 2>

Equivalent Plastic Strain 2 node, then click Surface 1.
2 In the Settings window for Surface, locate the Range section.
3 Sclect the Manual color range check box.
4 In the Maximum text field, type 0.08.
5 In the Equivalent Plastic Strain 2 toolbar, click Plot.
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